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Overview of Adobe Acrobat 
Adobe PDF is the foundation for workflows in the publishing industry. It also plays a key role in educational 
administrative services, and is used for producing applications, registration forms, surveys, lesson plans, and more. 
Editable PDF documents also allow teachers and students to publish and share documents for peer review.  


An Adobe PDF document preserves all the fonts, formatting, graphics, and color of any source document, regardless 
of the application and platform used to create it. Adobe PDF files are compact and can be shared, viewed, navigated, 
saved, and printed exactly as intended by anyone with the free Adobe Reader. You can convert any document to an 
Adobe PDF file by using Adobe Acrobat 9 Pro. 


Acrobat work area 


The Acrobat work area (Figure 1) includes a document pane that displays Adobe PDF documents and a navigation 
pane on the left side that helps you browse through an open PDF document. The toolbars are grouped at the top of 
the window according to feature type and provide the controls used to work with PDF documents. 


Pages can be viewed in the navigation pane. The Pages panel displays thumbnail page views and an indication of 
what portion of the page is visible. 


Bookmarks are also viewed in the navigation pane. Bookmarks are links to specific points of interest in the PDF 
document. 
 
 
 


 
Figure 1 Acrobat work area 


 


Toolbars Navigation pane Document pane 


Bookmarks 


Pages 







Adobe Acrobat guide 
 


2 Overview of Adobe Acrobat © 2008 Adobe Systems Inc. 


Acrobat toolbars 


The Acrobat toolbar area includes a set of toolbars grouped by feature type, some of which appear by default and 
some of which are hidden (Figure 2).  


To view or hide toolbars, click the View menu, and choose Toolbars. The check marks beside menu options indicate 
which toolbars are currently viewable. 


 


 


 


 


Figure 2 Acrobat toolbars 


The Tasks toolbar provides easy access to commenting and markup tools, security settings, form functions, menu 
commands associated with creating a PDF, and options for sending a document for review. 


The File toolbar allows you to open, save, print, and e-mail the current document. 


The Page Navigation toolbar provides buttons and page numbers to go to the page you want. 


From the Select & Zoom toolbar, you can use the Select, Hand, and Marquee Zoom tools, as well as tools and 
settings that adjust the size and view of the current document. 


Use the Find toolbar to search for text contained within a PDF document. 


 


File toolbar 


Tasks toolbar


Select & Zoom 
toolbar


Find toolbar Page Navigation 
toolbar 








 Adobe Acrobat step-by-step guide 
 


© 2008 Adobe Systems Inc. Creating PDF documents 1 


Creating PDF documents 
With Adobe Acrobat 9 Pro, you can convert a variety of file formats to Adobe Portable Document Format (PDF), a 
universal file format that preserves all the fonts, formatting, images, and color of a source file, regardless of the 
application and platform used to create it. Adobe PDF files are compact and can be exchanged, viewed, navigated, 
and printed by anyone with free Adobe Reader software, while maintaining document integrity. 


Converting files to PDF format 


You can choose from several PDF creation methods, depending on the type of file you start with and your 
requirements for the PDF. 


There are a number of ways to create PDFs. For instance, if a file is open in its authoring application (such as a 
spreadsheet that is open in Microsoft Excel), you can usually convert the file to PDF without starting Acrobat. 
However, every PDF strikes a balance between efficiency (small file size) and quality (such as resolution and color). 
When that balance is critical to your task, you’ll want to convert the files by using Acrobat, because that method 
includes access to various conversion options. 


To convert a file to PDF: 


1. In Acrobat, do one of the following: 


 Click the File menu, click Create PDF, and click 
From File. 


 In the toolbar, click the Create button and click 
PDF From File. 


2. In the Open dialog box (Figure 1), select the file. You 
can browse all file types or select a specific type from 
the Files Of Type menu. 


3. Optionally, click Settings to change the conversion 
options. The options available vary depending on the 
file type and include such settings as adding bookmarks 
automatically, implementing security settings, and 
managing color or compression. 


 The Settings button is unavailable if you choose All 
Files as the file type or if no conversion settings are 
available for the selected file type. 


4. Click Open to convert the file to a PDF. 


 Depending on the type of file you are converting, the 
authoring application starts automatically or a progress 
dialog box appears. If the file is in an unsupported 
format, a message appears telling you the file cannot be 
converted to PDF. 


 


 


Figure 1 Open dialog box 
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5. When the new PDF opens, click the File menu and 
click Save (or Save As). Then select a name and 
location for the PDF. 


 When naming a PDF that’s intended for distribution via 
the web or e-mail, consider limiting the filename to 
eight characters (with no spaces) and include the .pdf 
extension. This ensures that email programs or network 
servers don’t truncate the filename and that the PDF 
opens as expected. 
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Creating PDF documents from web pages 
You can use Adobe Acrobat 9 Pro to capture web pages and convert them into a PDF for viewing offline. When you 
convert a web page to PDF, the HTML file and all associated files—such as JPEG images, Adobe Flash files, 
cascading style sheets, text files, image maps, and forms—are included in the conversion process. 


The resulting PDF behaves much like the original web page. For example, the images, links, image maps, and most 
media files appear and function normally within the PDF. (Animated GIF files appear as still images, showing the 
last frame of the animation.) 


Converting web pages to PDF format 


In preparing to convert web pages to PDF, consider the following factors, which affect how you approach the 
conversion process: 


 How much do you want to convert? If you want to convert several levels or all of a multipage website to PDF, 
work within Acrobat. 


 Do you want to create a new PDF from the web pages or to append the converted pages to an existing PDF? 
You can do both in either Acrobat or Internet Explorer, but you choose different buttons or commands to 
accomplish these things. 


 How complicated is the web page? Some web pages display differently in different browsers, and a web page 
that uses unconventional code or media may not convert the way you expect it to. If you have difficulty 
converting a particular web page to PDF, consider linking to the web page instead. 


To convert a web page to PDF: 


1. Click the File menu, click Create PDF, and click 
From Web Page. 


2. In the Create PDF From Web Page dialog box 
(Figure 1), enter the complete path to the web page or 
click Browse and locate an HTML file. 


3. To change the number of levels in the website to 
convert (that is, the depth of links Acrobat should 
follow), click Capture Multiple Levels.  


4. Enter the number of levels to include, or select Get 
Entire Site to include all levels from the website. 


 Some websites have hundreds or even thousands of 
pages. Converting a large website can make your 
system slow and unresponsive and can even use up 
available hard-drive space and memory, causing a 
system crash. A good idea is to begin by downloading 
one level of pages and then go through them to find 
particular links to download. 


 


Figure 1 Create PDF from Web Page dialog box 
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4. If Get Only N Level(s) is selected, select one or both of 
the following options: 


 Stay On Same Path: Downloads only web pages 
subordinate to the specified URL. Select this 
option if you want to capture only a particular 
section of a website. 


 Stay On Same Server: Downloads only web pages 
stored on the same server. Select this option if you 
want to avoid capturing web pages from other 
websites - pages your target website links to. 


5. Click Settings, change the selected options in the Web 
Page Conversion Settings dialog box as needed 
(typically you can use the default settings), and click 
OK. 


6. Click Create. 


 You can view PDF pages while they are downloading; 
however, you cannot modify a page until the download 
process is complete. 


7. If you closed the Download Status dialog box, click 
Advanced, click Web Capture, and click Bring Status 
Dialogs To Foreground to see the dialog box again. 
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Adding links and buttons to PDF documents 
In Adobe Acrobat 9 Pro, links and buttons are useful tools for increasing the interactivity of a PDF document. 


Links, or hyperlinks, let readers go instantly from one place in a document to nearly any other location, whether that 
location is on the same page, in the same document, in a different document, or even on the World Wide Web. Links 
are very useful for ensuring that your reader has immediate access to related information. Links can be visible or 
hidden and—like bookmarks and buttons—can also initiate actions. 


Buttons, most commonly associated with forms, are visual objects you can add to any type of PDF document. 
Buttons can add interactivity by initiating a single action or a series of actions and can be copied across multiple 
pages of a document. A button can also display alternate appearances and activate different actions depending on 
mouse behaviors such as Mouse Down (a click) and Mouse Up (release after a click). 


Creating links in a PDF document 


You can link from one part of a PDF document to another part of the same document. You can also use the same 
method to link one PDF document to another PDF document.  


To create a link in a PDF document: 


1. Open the document that will contain the link. 


2. Click the Tools menu, click Advanced Editing, and click 
Link Tool. 


 The cursor changes to a cross hair. 


3. Draw a rectangle around the text or object you want 
viewers to click to activate your link. 


 The Create Link dialog box appears (Figure 1), showing 
the properties you can assign to the link. 


4. Use the Link Appearance section of the Create Link 
dialog box to set the appearance of the link. 


5. In the Create Link dialog box, click Go To A Page View 
and click Next. 


 The Create Go To View dialog box appears (Figure 2). 


6. With the Create Go To View dialog box displayed, 
navigate to the page you want the link to open. 


 


 


 


Figure 1 Create Link dialog box 


 


 


Figure 2 Create Go To View dialog box 
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7. Use the zoom controls to set the zoom level of the 
document that viewers see when they open the document. 


8. In the Create Go To View dialog box, click Set Link. 


9. To test the link, click the Tools menu, click Select & 
Zoom, and click Select Tool. Then click the link. 


10. To change the appearance or behavior of the link, click 
Tools, click Advanced Editing, and click Link Tool. Then 
double-click the link and change the link settings in the 
Link Properties dialog box. 


 


 To link to an external site: 


1. Open the document that will contain the link. 


2. Click the Tools menu, click Advanced Editing, and click 
Link Tool. 


 The cursor changes to a cross hair. 


3. Draw a rectangle around the text or object you want 
viewers to click to activate your link. 


 The Create Link dialog box appears (Figure 3), showing 
the properties that can be assigned to the link. 


4. Use the Link Appearance section of the Create Link 
dialog box to set the appearance of the link. 


5. In the Create Link dialog box, click Open A Web Page 
and click Next. 


 The Edit URL dialog box appears (Figure 4). 


6. In the Edit URL dialog box, enter the address of the web 
page or website you want the link to open. Then click OK. 


7. To test the link, click the Tools menu, click Select & 
Zoom, and click Select Tool. Then click the link. 


8. To change the appearance or behavior of the link, click the 
Tools menu, click Advanced Editing, and click Link Tool. 
Then double-click the link and change the link settings in 
the Link Properties dialog box. 


 


Figure 3 Create Link dialog box 


 


 


Figure 4 Edit URL dialog box 
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Creating buttons in a PDF document 


With the Button tool, you can create a more customized visual navigation system for your PDF file even if your 
document is not a form. Buttons have the following capabilities: 


 A button can activate a series of actions. 


 A button can have alternate appearances, determined by mouse behavior when over the button. 


 A button can be easily copied across many pages. 


To create a button in a PDF document: 


1. Select the Button tool from the Advanced Editing 
toolbar. 


2. Drag the cross-hair pointer to create the button area. 
The Button Properties dialog box opens. 


3. Click the General tab (Figure 5), and specify a name, 
tooltip text, and common properties. If you want the 
button to appear onscreen but not print with the page 
content, select Visible but doesn’t print from the Form 
Field pop-up menu. 


4. Click the Appearance tab, and specify options to 
determine how the button will look on the page. If you 
select a background color, you won’t be able to see 
through to any images behind the button. The text 
options affect the label you specify in the Options tab, 
not the button name in the General tab. 


5. Click the Options tab (Figure 6), and select options to 
determine how labels and icons appear on the button. 
Make sure to enter a value in the Label box or the 
bottom will not have a visible label name. 


6. Click the Actions tab, and specify options to determine 
what happens when the button is clicked, such as going 
to the next page or printing the current document. 


7. Click Close. 


 To test your button you’ll need to select the Hand or 
Select tool and click on the button in the document 
pane. 


 


Figure 5 Button Properties, General tab 


 


 


Figure 6 Button Properties, Options tab 
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Inserting rich media into PDF documents 
Adobe Acrobat 9 Pro allows you to insert rich media files, such as video, sound, or Flash documents, into PDF 
documents.   


When placing video, audio, or Flash content in a PDF document, Acrobat converts the file to a format that can be 
played by Adobe Reader. Anyone with the free Adobe Reader software can view and/or hear the media without 
additional software. 


PDFs can include Flash (SWF/FLV), QuickTime, MP3, MPEG, and Windows Media files, among others. You can 
play these files directly from the page or activate them from a link or a bookmark. Each multimedia file includes a 
play area from which you can activate the media. The play area typically appears on the PDF page as an image or a 
rectangle but can also be invisible. 


When you add a video file to a PDF document, Acrobat automatically converts the video to an FLV file. This format 
ensures both high-quality viewing and compatibility across computer platforms. FLV files are also compact, so 
converting multimedia to this format helps reduce the size of the PDF. Acrobat converts the following video file 
formats to FLV: ASF, ASX, AVI, 3GPP, MOV, MP4, MPEG, MPG, QT, and WMV files.  


Note: All multimedia that is H.264 compliant can be played back in Adobe Reader  9 and later. (H.264, also known 
as MPEG-4 part 10, is a video compression standard that provides high-quality video without substantially 
increasing file size.) Video files of varying formats and filename extensions can be H.264 compliant.  


To add video to a PDF document: 


1. Open the PDF document. 


2. Click the Tools menu, click Multimedia, and click Video 
Tool. 


3. Drag or double-click to select the area on the page where 
you want the video to appear. 


 The Insert Video dialog box appears (Figure 1). 


 If you double-click the page, Acrobat places the upper left 
corner of the video where you clicked. If you drag an area 
on the page, the media is placed within the area. The play 
area of the video is the exact size of the video frame (if 
Acrobat is able to read the video clip dimensions). 


4. Add a URL in the File field, or click Browse to find the 
video file. 


 For URLs, use the full file address, including the video 
filename extension, such as .flv or .mp4. 


5. (Optional) To specify which playback controls will be 
displayed for the video, click Show Advanced Options. 
Then select the Controls tab. In the Skin menu, select 
which set of controls to use. 


6. (Optional) To select an image to be displayed when the 
video isn’t playing, click Show Advanced Options. Then 
select the Video tab. Move the marker above the slider bar 
to the frame you want to use, and then click Set Poster 
Image From Current Frame. 


7. Click OK to close the Insert Video dialog box. 
 


 


Figure 1 Insert Video dialog box 
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The video may take a few seconds to process before it 
appears in the location you specified. 


8. To play the video, use the Hand tool or the Select tool to 
click the play area of the video file. When the pointer is 
positioned over the play area, it changes to the play mode 
icon. 


To add Flash documents to a PDF document: 


1. Open the PDF document. 


2. Click the Tools menu, slick Multimedia, and click Flash 
Tool. 


3. Drag or double-click to select the area on the page where 
you want the Flash movie to appear. 


 The Insert Flash dialog box appears (Figure 2). 


 If you double-click the page, Acrobat places the upper left 
corner of the video where you clicked. If you drag an area 
on the page, the media is placed within the area. The play 
area of the movie is the exact size of the video frame. 


4. Add a URL in the File field, or click Browse to find the 
Flash document, and then click Open. 


 For URLs, use the full file address, including the filename 
extension. 


5. Click OK. 


 The Flash document appears in the PDF document. 


6. To play the Flash document, use the Hand tool or the 
Select tool to click the play area of the Flash document. 
When the pointer is positioned over the play area, it 
changes to the play mode icon.  


 


Figure 2 Insert Flash dialog box 
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To add sound to a PDF document: 


1. Open the PDF document. 


2. Click the tools menu, click Multimedia, and click Sound 
Tool. 


3. Drag or double-click to select the area on the page where 
you want to place the sound. 


 The Insert Sound dialog box appears (Figure 3). 


 If you double-click the page, Acrobat places the upper left 
corner of the sound play area where you clicked. If you 
drag an area on the page, the media is placed within the 
area. 


4. Add a URL in the File field, or click Browse to find the 
media file, and then click Open. 


 For URLs, use the full file address, including the filename 
extension. 


5. (Optional) To specify advanced options (such as what 
image, or “poster,” to display in the sound play area), 
click Show Advanced Options. 


6. Click OK. 


 A play area representing the sound appears in the PDF 
document. 


7. To play the audio, use the Hand tool or the Select tool to 
click the sound play area. When the pointer is positioned 
over the play area, it changes to the play mode icon.  


 


Figure 3 Insert Sound dialog box 


 


Converted media require Adobe Reader 9 or Acrobat 9 for playback. Viewers who attempt to play converted media 
in earlier versions of Adobe Reader or Acrobat are prompted to upgrade to Adobe Reader 9 or Acrobat 9. 
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Adding Adobe Presentations to PDF documents 
Using Adobe Presenter, you can publish an Adobe Presentation from within Microsoft PowerPoint as a PDF 
document.  


A published Adobe Presentation plays within the Adobe Presenter viewer. This includes controls for playback and 
navigation (Figure 1). In Adobe Presenter, you can select from a collection of themes and publish settings that 
change the look and behavior of the Adobe Presenter viewer.  


Publishing as an Adobe PDF file 


When you publish an Adobe Presentation as an Adobe PDF file, the entire presentation, along with the Adobe 
Presenter viewer and navigation controls, are self-contained within a single PDF file. Opening the PDF file will play 
the presentation automatically (Figure 1). You must have Acrobat Reader 9 or later to view the document. 


 


 


Figure 1 Adobe Presentation published to an Adobe PDF file 
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To publish an Adobe Presentation to an Adobe PDF document: 


1. Start PowerPoint, open the presentation to convert to a 
PDF, click the Adobe Presenter ribbon or menu, and 
then click Publish. 


 The Publish Presentation dialog box appears. 


2. Select Adobe PDF. 


3. Click the Choose button, and navigate to the folder 
where you want to publish the presentation. Select the 
folder you want. 


4. Enter a filename and click Save (Figure 2). 


5. Click Publish. 


 The published file is converted to an Adobe Presentation 
contained within a PDF document. 


 To play the presentation, simply open the PDF 
document (Figure 3). The entire presentation, including 
the Adobe Presenter viewer, is contained within a single 
document. 


 You must have Acrobat Reader 9 or later to view the 
document. 


Figure 2 Publish As PDF dialog box 


 


Figure 3 Presentation in PDF document 
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Using Acrobat Commenting and Markup tools 
When collaborating with other faculty or students, there will be times when your PDF documents are created, 
reviewed, or edited as a team.  This type of collaboration requires the ability to track review peer comments and 
document editing with detailed records and precision. This will allow for more effective communication and 
document version control. 


The Adobe Acrobat 9 Pro commenting and markup tools allow you to insert detailed comments, highlight, replace, 
insert, and delete text, mark a document with a customized stamp, and use graphics to communicate with other 
document authors, reviewers, and editors. You can use these tools in several ways: 


 The commenting tools are useful for assessing high-level conceptual and procedural knowledge. 


 The text tools are useful for detailed spelling, grammar, and general writing evaluation. 


 Custom stamps are useful to track the review process through document revisions and additional rounds of 
edits. 


 The graphic markup tools are useful for evaluating peer documents that includes images or other non-text 
content. 


Comment & Markup toolbar 


The Comment & Markup toolbar includes the tools for document review and editing (Figure 1).  
 


 
Figure 1 Comment & Markup toolbar 


 


Sticky Note tool 


Insert comments at specific locations by using the Sticky Note tool. Sticky notes are ideal for long or short 
comments that are general or overarching in their nature. For example, you might use a sticky note to critique a 
student’s overall theory in a research paper or to provide detailed comments on a collection of images from a 
semester-long photography portfolio. 
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To add a sticky note comment: 


1. Click the Tools menu, click Comment & Markup, and 
click Show Comment and Markup Toolbar. 


2. Click Sticky Note (Figure 2) on the Comment & Markup 
toolbar, and either click where you want to place the note 
or drag to create a custom-sized note. 


3. Type text in the pop-up sticky note (Figure 3). 


4. You can reposition the sticky note icon by dragging it to a 
new location. 


 


 


Figure 2 Comment & Markup toolbar 


 


 


 


Figure 3 Sticky note 


 To edit a sticky note comment: 


1. Click or double-click the sticky note icon. 


 Double-clicking opens and closes the pop-up sticky note. 


2. Make changes, as needed: 


 To resize the pop-up note, drag the lower-left or 
lower-right corner (Figure 4). 


 To change the appearance of the sticky note, click the 
Options pop-up menu in the sticky note and click 
Properties. The Sticky Note Properties dialog box 
opens. Make your changes and click OK. 


3. When you finish, click the minimize button in the upper-
right corner of the pop-up note, or click outside the pop-up 
note. 


 If you want to change the font size, default pop-up 
behavior, and other settings for creating and viewing 
comments, use the Commenting panel in the Preferences 
dialog box (Figure 5). To display the Commenting 
preferences, click the Edit menu, click Preferences, and 
then select the Commenting category. 


 


 


 


Figure 4 Sticky note 


 


 


Figure 5 Commenting preferences 


 


Sticky Note tool


Sticky note icon Pop-up note 


Drag to resize 
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To delete a sticky note: 


1. Click to select the sticky note icon, and press Delete. 


 Alternatively, double-click the sticky note icon and 
choose Delete from the Options pop-up menu (Figure 6). 


 


 


Figure 6 Sticky Note Options menu 


Text-editing tools 


Provide specific mark up on sections of text by using the text-editing tools. The tools allow you to highlight, insert, 
underline, or cross out text digitally, much as you would edit on paper. Standard editing symbols correspond to the 
use of each tool so students can quickly determine the edits you have provided for their work. These tools are 
valuable for marking up problems with grammar, vocabulary, spelling, or sentence structure and for providing very 
specific comments on small portions of text. 


Pop-up notes associated with the tools show the date and time of the edit and provide room for your comments. 
They can be minimized to avoid unnecessary clutter. Students can see your edits and notes by hovering over the 
editing symbol within the marked-up text or by double-clicking the editing symbol to reveal the pop-up note. 
 


Replace Selected Text    Show places where text should be replaced and provide alternate text in a pop-up note. 


Highlight Selected Text    Cause text to be highlighted yellow. Note: The Highlight Text tool is also available on 
the main Comment & Markup toolbar. 


Add Note To Selected Text    Include a specific comment that is linked to highlighted text by a pop-up note. 


Insert Text At Cursor    Mark a spot where text needs to be inserted and provide that inserted text with the Insert 
text At Cursor tool. 


Underline Selected Text    Underline to denote emphasis on a specific piece of text. 


Cross Out Text for Deletion    Visually cross out the selected text. 
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To replace selected text: 


1. Click the Text Edits button on the Comment & Markup 
toolbar.   


 If a message opens explaining each of the tools, read the 
message and click OK to close it. 


2. Select the text you wish to replace in the document. 


3. Click to open the Text Edits pop-up menu, and click 
Replace Selected Text (Figure 7). 


4. The text you selected is crossed out and a pop-up note is 
created that is linked to the crossed-out text (Figure 8). 


 If the Replacement text pop-up note is not visible, double-
click the crossed out text to open it. 


5. Type the replacement text into the pop-up note.  


 The steps for using the Add Note To Selected Text, Insert 
Text At Cursor, Underline Selected Text, and Cross Out 
Text For Deletion tools are the same as the steps for the 
Replacing Selected Text tool. 


 


Figure 7 Text Edits menu 


 


 


Figure 8 Replacement Text pop-up note 


To highlight text: 


1. Click the Highlight Text button on the Comment & 
Markup toolbar (Figure 9). 


2. Select the text you wish to highlight. The selected text is 
highlighted in yellow. 


3. Double-click the highlighted text to reveal the pop-up note 
associated with the text (Figure 10). Type your comment 
into the pop-up note.   


 


 


Figure 9 Comment & Markup toolbar 


 


 


Figure 10 Highlight Text pop-up note 
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Stamp tools 


When you are exchanging documents repeatedly or using multiple reviewers, consider using the stamp tools. 
Reviewers can use stamp tools to mark the document with a permanent graphic that denotes the document’s status. 
Students might use this tool to mark a document as a draft. You can stamp a document with a graphic that shows 
when you received the document and when you completed your review. Multiple reviewers can stamp a document, 
providing a clear history of the review process. Acrobat provides a number of preset stamps and lets you create and 
design custom stamps. 


Preset stamps 


Acrobat provides a set of Dynamic stamps that denote the document status, automatically generate the time and date 
of review, and provide the option to show the reviewer’s name. The five preset Dynamic stamp options are Revised, 
Reviewed, Received, Approved, and Confidential. Dynamic stamps are an excellent way to quickly mark a 
document with important details about the receipt or review of a student’s coursework. Acrobat also includes a set of 
Standard Business stamps that may be useful for digital assessment. The Draft, Final, Completed, and For Comment 
Standard Business stamps may provide more detailed status indicators during the assessment process. 


To add and edit a preset stamp: 


1. Open the Comment & Markup toolbar. 


2. Open the Stamp tool pop-up menu (Figure 11) and click 
Dynamic or Standard Business. 


2. Click to select the appropriate stamp.  


 If this is the first time using a stamp, you may be 
presented with the Identify Stamp dialog box (Figure 12). 
Use this to enter your personal information, and click 
Complete. 


 Your chosen stamp appears in a faded-out color and 
moves with your cursor.  


3. Click on the page where you want the stamp to appear. 


 


 


Figure 11 Dynamic stamps menu 


 


 


Figure 12 Identity Setup dialog box 
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 The stamp appears in full color (Figure 13). 


 Some stamps include your personal information and the 
date and time of the stamp. Your identity will default to 
what you entered the first time you used a Dynamic or 
Standard Business stamp. To edit your identity details 
click the Edit menu, click preferences, and select the 
Identity category on the left. Make changes and click OK. 


4. To edit or delete a stamp, click on it. 


 The stamp is surrounded by a selection border and 
size/transform handles.  You can use the handles to scale, 
rotate, or move the stamp.  


5. Right-click (Windows) or Ctrl-click (Mac OS) and choose 
delete from the menu to remove the stamp (Figure 14). 


6. To attach a pop-up note to a Dynamic or Standard 
Business stamp, right-click (Windows) or Ctrl-click (Mac 
OS) and select Open Pop-Up Note or simply double-click 
the stamp. Type the desired text into the pop-up note. 


 


Figure 13 Reviewed Dynamic stamp sample 


 


 


Figure 14 Stamp with size/transform handles and 
the stamp options menu open. 


Custom stamps 


Sometimes the Dynamic stamps might not suit your purposes. Acrobat also gives you the option to create custom 
stamps. You might find it more personal to create a custom stamp with an image, a graphic, or your initials as the 
stamp. You might consider creating a set of grading stamps to clearly display the letter grade assigned to a student’s 
work. 


To create a custom stamp: 


1. Open the Stamp tool pop-up menu, and click Create 
Custom Stamp (Figure 15). 


 


 


Figure 15 Stamp tool pop-up menu 
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2. In the Select Image for Custom Stamp dialog box 
(Figure 16), click Browse to locate the image you want to 
use as your custom stamp. Select the image file and click 
Select.  


 The image is added to the dialog box. 


3. Click OK. 


4. In the Create Custom Stamp dialog box (Figure 17), type 
a new category into the Category field or select from the 
preset categories. Assign a name to your custom stamp. 
Make sure the Down Sample Stamp To Reduce File Size 
checkbox is selected. If you need to, you can select a 
different image for the custom stamp by clicking the 
Select Image For Custom Stamp button. Click OK. The 
custom stamp has now been created. 


4. Follow the directions given earlier for adding and editing 
a stamp. 


 If you created a new category for your custom stamp, the 
new category appears in the Stamp menu. If you selected 
one of the preset stamp categories, you can find the 
custom stamp in the selected category. 


 


 


 


Figure 16 Select Image for Custom Stamp dialog 
box 


 


 


Figure 17 Create Custom Stamp dialog box 
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Markup tools: 


Acrobat provides a number of tools for graphically marking areas of a document for review and editing. These 
drawing markup tools provide several ways to communicate with others when collaborating on a shared document. 


You can also include detailed text comments with each of your markups to provide further communication. To use 
these tools, select them from the Comment & Markup toolbar, and then drag to place the drawing markup on the 
page. You can then double-click the markup to add your notes. 


Callout tool   Create an arrow pointing to a specific location and a linking box into which you can type text. 


Text Box tool    Places a box on top of the document into which you can insert text. 


Cloud tool    Click around an object or text to draw a cloud around it. 


Line and shape tools   Draw an arrow, line, rectangle, or oval to highlight specific elements in 
a document. 


Pencil tool   Draw freeform on a document. 


Showing and hiding comments and viewing the Comments List 


Acrobat enables users to show and hide all comments, view comments in a list form, and show sets of comments 
grouped by type, reviewer, or status. These functions can be helpful when multiple reviewers are involved in editing, 
when student assignments go through multiple rounds of reviews, or when you have a lengthy document with 
numerous comments. 


Within the comments view, you can also show and hide selected comments by using the Show button. You can 
show by type, reviewer, or status. 


To show and hide comments: 


1. Do one of the following: 


 Click the Comments menu, click Comment View, and 
click Show All Comments. 


 Click the Show button on the Comment & Markup 
toolbar, and click Show All Comments (Figure 18). 


 The Show All Comments option is only available if all 
your comments are hidden. If your comments are 
currently visible, the Hide All Comments option is 
available. 


 


Figure 18 Show/Hide Comments menu 


To show and hide the Comments List: 


1. Do one of the following: 


 Click the Comments menu, cock Comment View, and 
click Show Comments List. 


 Click the Show button on the Comment & Markup 
toolbar, and click Show Comments List (Figure 19). 


 The Show Comments List option is only available if the 
Comments List is hidden. If the Comments List is visible, 
the Hide Comments List option is available.   


 


Figure 19 Show/Hide Comments List menu 
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To show and hide selected comments: 


1. In the Comments List toolbar, click the Show button and 
select the category you wish to sort by (Figure 20). You 
can sort by Type or Reviewer, among other options. The 
comments are shown according to the setting you select, 
and a shaded yellow bar states that “Comments are hidden 
because a filter is active in the Show menu.” 


 The first time you sort comments, you will see a dialog 
box explaining each of the tools. You can select the Don’t 
Show Again dialog box if you wish to avoid this message 
in the future. 


2. To display all the comments in the Comments List again, 
click the Show button in the Comments List toolbar 
(Figure 20) and select Show All Comments. 


 


 


Figure 20 Comments List Show menu 


 


To sort, navigate, expand, reply to, and delete comments in the Comments List: 


1. To sort through the comments, click the Sort By button in 
the Comments List toolbar. From the menu, select the 
category you wish to sort by (Figure 21). You can sort by 
Type, Page, Author, or Date, among other options. The 
comments are sorted according to the setting you select. 


 The first time you sort comments, you will see a dialog 
box explaining each of the tools. You can select the Don’t 
Show Again dialog box if you wish to avoid this message 
in the future. 


2. To navigate through the Comments List, select a comment 
by clicking on it. Then use the Next and Previous buttons 
in the Comments List toolbar to navigate through the 
comments. As you highlight each comment in the list, the 
document pane adjusts to show the comment within the 
original document. Alternatively, you can simply click on 
comments in the list to navigate through them. 


3. To expand or collapse lengthy comments, select a 
comment and click the Or button next to it in the list. 
Additionally, you can expand or collapse all comments by 
using the Expand All and Collapse All buttons in the 
Comments List toolbar. 


4. To reply to a comment, first select the comment you wish 
to reply to. In the Comments List panel, click the Reply 
button. This creates a sticky note addendum to the 
comment. Type your reply in the space provided. 


5. To delete a comment, select the comment in the list and 
click the Delete button. 


 


Figure 21 Comments List Sort By menu 
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Using audio commenting 


Acrobat includes an audio commenting feature that you can use to attach audio comments to PDF documents. Audio 
commenting adds a personal touch to document review and collaboration. You can provide encouragement or 
motivation through an audio comment that is often hard to convey in text. Also, audio comments may be easier and 
more effective when your comment is lengthy or you are explaining a difficult concept. The built-in microphones on 
most computers should be sufficient for recording audio comments. 


Note: Audio commenting can quickly increase the size of your document file. Be aware of others’ capabilities for 
sending and receiving large files. 


To add an audio comment: 


1. Click the Comments  menu, click Comment & Markup 
Tools, and click Record Audio Comment.  


 Your cursor changes to a speaker icon. 


2. Click to place the audio comment in a specific location in 
the document.  


 The Sound Recorder appears (Figure 22). 


3. If you have already recorded audio in a separate 
application, you can click Browse to select the audio file. 
Otherwise, click the red record button to begin recording. 
Using your computer’s built-in microphone, record the 
audio comment you wish to make. Click the stop button 
when you finish. You can review your audio comment by 
clicking the play button. Move the slider left and right to 
review portions of your audio comment. You can click the 
record button again to record additional comments. When 
you are satisfied with your audio comment, click OK. 


4. You may wish to make adjustments to the appearance of 
the audio comment. In the Sound Attachment Properties 
dialog box (Figure 23) you can change the icon style, 
color, and opacity of the comment marker. Click OK. 


5. The audio comment icon appears on the page at the 
desired location. To listen to the audio comment, double-
click the audio comment icon or right-click (Windows) / 
Ctrl-click (Mac OS) on the icon and select Play File 
(Figure 24). 


6. To delete the audio comment, right-click (Windows) / 
Ctrl-click (Mac OS) the audio comment icon and select 
Delete Figure 24). 


 You cannot edit audio comments in Acrobat. 


 


 


Figure 22 Sound Recorder 


 


 


Figure 23 Sound Attachment Properties dialog box 


 


 


Figure 24 Audio comment menu 
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Reviewing and commenting on video 


When you view a video embedded in a PDF, you can add comments to individual frames. Each comment is attached 
to a specific frame so the comments appear in the context in which they were made.  Frame-by-frame video 
commenting makes the review and revision processes quicker and more efficient. 


To comment on a frame of video: 


1. Use the Flash Player navigation controls to navigate to the 
frame in the embedded Flash Video you wish to comment 
on. 


2. Use the Sticky Note tool, Stamp tool, or any of the 
graphical markup tools to comment on specific frames in 
the video. As you create a comment, Acrobat 
automatically attaches a pop-up note (Figure 25) with the 
video time code referencing the specific frame in the 
video to which the comment applies. Type your comment 
in the pop-up note. 


3. You can view all the comments on the embedded video by 
using the Comments List. Comments on video assets 
contain a small blue cube in the comment icon. The list 
shows the comments in the order in which they appear in 
the video. As you navigate through the Comments List, 
the video jumps to the point in the timeline where the 
comment was made. 


 


Figure 25 Sticky note comment on a frame of video 


Creating summary documents 


When you have completed your commenting and markup of a document, you can create a summary document as a 
convenient container for all your comments. This feature may be useful for documents that have many comments or 
markups that are difficult to view simultaneously within the original document. 


To create a comment summary document: 


1. Click the Comments menu, and click Summarize 
Comments. 


2. In the Summarize Options dialog box (Figure 28), choose 
from the following layouts and settings for your summary 
document: 


 Document and comments with connector lines on 
separate pages 


 Document and comments with connector lines on 
single pages 


 Comments only 


 Document and comments with sequence numbers on 
separate pages 


3. Click the Create PDF Comment Summary button.  


 Acrobat automatically creates the summary document and 
opens it in a new window. 


4. Save the new summary document with the desired 
filename and location. 


 


Figure 28 Summarize Options dialog box 
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Collecting comments from multiple reviewers 


When document collaboration calls for multiple reviewers, you can use the built-in shared reviewing tools to make 
this process easy. You can automatically attach a PDF document to an e-mail that contains instructions for 
reviewing and returning the document. The collaborative reviewing features make it easy to collect comments from 
multiple reviewers—be they teachers or students in a peer review group.   


To attach a PDF document for e-mail review: 


1. To initiate an e-mail review, you must first set your 
identity in the Identity pane of the Preferences dialog box 
(Figure 29). To do this, click the Edit menu and click 
Preferences. Select Identity from the Category options on 
the left. Enter your information. The Email Address field 
is required for reviewers to be able to automatically return 
the document to you. When finished, click OK. 


2. Save the document. 


3. Click the Comments menu, and click Attach for Email 
Review. 


4. In the Getting Started dialog box (Figure 30), browse for 
the file you wish to send for review. Acrobat 
automatically inserts the current document you are 
working on into the field.  


5. Click Next. 


 


 


 


 


Figure 29 Identity Preferences dialog box 


 


 


Figure 30 Getting Started dialog box 
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5. In the Invite Reviewers dialog box (Figure 31), enter the 
e-mail addresses of the people you wish to invite to 
review your document. Separate e-mail addresses by 
commas or put each address on a separate line. Click 
Next. 


6. In the Preview Invitation dialog box (Figure 32), change 
the subject and text of the e-mail reviewing invitation to 
provide custom instructions to your reviewers. Click Send 
Invitation. Acrobat automatically creates an e-mail 
message in your default e-mail application and sends it to 
each reviewer. 


7. The Outgoing Message Notification appears (Figure 33). 
Read the notification carefully and note that you may have 
to manually send the e-mail message. Click OK.  


 Your document has now been sent for review. 


 


 


 


 


Figure 31 Invite Reviewers dialog box 


 


 


Figure 32 Preview Invitation dialog box 


 


 


Figure 33 Outgoing Message Notification 
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To receive and return an e-mail review: 


1. In your e-mail application, open the e-mail review 
message from the person who is asking you to review a 
document. Save the attached document to your desired 
location on your computer. Open the document in Acrobat 
6 or later or in Reader 7 or later. 


2. A shaded yellow document status notification appears 
across the top of the document, with instructions for 
commenting on the document and returning it to the 
sender (Figure 34). 


3. Use the commenting and markup tools to provide your 
review of the document. When you finish, click the Send 
Comments button in the shaded yellow document status 
notification (Figure 34) to return your comments to the 
review initiator. Acrobat automatically creates an e-mail 
in your default e-mail application and sends it to the 
review initiator. 


 


Figure 34 Document status notification 


To migrate comments from a separate document: 


1. In Acrobat, open the document you wish to migrate 
comments from and the document that you wish to 
migrate comments to. 


2. In the document you wish to migrate comments to, click 
the Comments menu, and click Migrate Comments. 


3. In the Migrate Comments dialog box (Figure 35), select 
the file you wish to migrate comments from. Make sure 
the Review Migrated Comments In The Comment List 
box is selected. Click OK. The comments are migrated to 
the corresponding location in the destination document 
and the Comments List shows the migrated comments. 


 


Figure 35 Migrate Comments dialog box 


Commenting with Adobe Reader 


Acrobat document authors can enable commenting rights in their PDF documents so users of the free Adobe Reader 
can participate in the markup and review process. 


To enable commenting rights for Adobe Reader: 


1. In Acrobat, click the Comments menu, and click Enable 
for Commenting And Analysis  


2. In the Save As dialog box, save the file with the desired 
name and location. Send this version of the file to users 
who do not have Acrobat. 


 It is best to enable commenting rights for Adobe Reader at 
the conclusion of your review, as this feature may prevent 
you from using some of the comment and markup tools. 
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Creating PDF forms 
Adobe Acrobat 9 Pro can be used to create data collection forms including text entry fields, list boxes, check boxes 
radio buttons, and other features that can simplify filling out the form by the end user.  


In this guide, you learn to use Acrobat forms to simplify generating a weekly lesson plan. You can apply what you 
learn here to produce student applications, registration forms, surveys, and other documents used for data collection. 


A PDF document offers several advantages over a word-processing document or spreadsheet for creating forms: 


 Updating the form is easy. 


 Form elements and non-form elements are separate, so adding information to the form doesn’t disturb the layout 
of the form as it frequently does in word-processing documents and spreadsheets. 


 Layout is easier because you can place form fields anywhere without disturbing other elements on the page. 


 You have a wide range of form fields available. 


In this example form, you will collect most of the information in text fields. In some cases, however, one of the 
other types of fields may be useful. Acrobat provides a variety of form inputs (Figure 1).  


 


Figure 1 Acrobat form fields 


 


 Text fields: Let the user type text, such as name, address, or phone number. 


 List boxes: Display a list of options the user can select. If the list is longer than space allows, the user can scroll 
through the list. 


 Check boxes: Present yes-or-no choices for individual items. If the form contains multiple check boxes, the 
user can typically select as many or few of these as wanted 


 Radio buttons: Present a group of choices from which the user can select only one item. All radio buttons with 
the same name work together as a group. 


 Combo boxes: Let the user either choose an item from a pop-up menu or type a value. 


You can make changes to individual form field properties, such as providing default values for form fields or 
validating user input. These methods make filling in the PDF form easier for the end user, and result in more valid 
data. 


Text field 


List box 


Check boxes 


Radio buttons 


Combo box 
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Creating the form 


You can use Acrobat to create forms by using one of the following methods: 


 Convert an existing electronic document (for example, an Adobe PDF, Microsoft Word, or Excel document) to 
a PDF form. (In Mac OS, you can only convert an existing PDF file.) 


 Scan a paper form to convert it to a PDF form. 


 Create a form from scratch or from a template by using Adobe LiveCycle Designer ES. LiveCycle Designer is a 
graphical form design tool that contains advanced features and controls. It is a stand-alone application included 
with Acrobat Pro or Acrobat Pro Extended for Windows. 


In this section, you learn how to create a form by converting an existing electronic document.  


To convert a form to PDF: 


1. Start Acrobat. 


2. Click the Forms menu, and click Start Form Wizard. 


 The Create or Edit Form wizard appears (Figure 2), 
asking what type of document you want to open as a 
form. 


3. In the Create or Edit Form wizard, select An Existing 
Electronic Document. Then click Next. 


4. In the next pane of the wizard (Figure 3), you indicate 
which document to convert. Make sure Import A File 
From File System is selected. 


5. Click the Browse button and locate the file you want to 
open.  


6. Click Next. 


 Acrobat processes your document, analyzing it for areas 
that appear to be form fields. Then it opens the 
converted document with suggested form fields. 
 
 


Figure 2 Indicate the type of document to convert 


 


Figure 3 Locate the document to convert 
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 The Welcome To Form Editing Mode dialog box also 
appears (Figure 4), reminding you to review your form 
and add any fields Acrobat may have missed. 


7. Click OK to close the Welcome To Form Editing Mode 
dialog box. 


 Once your form has been converted, you see the 
document in form-editing mode, with the form fields 
listed in the Fields navigation panel on the left 
(Figure 5). 


 


Figure 4 Welcome To Form Editing Mode dialog 
box 


 


 
Figure 5 Form-editing mode 


Fields panel 
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Adding fields to the form 


In form-editing mode, you see several controls (Figure 6) at the top of the Form Editing workspace. 


 


Figure 6 Form Editing controls 


 Selection tool: With this tool selected, click an object on the form to select it; double-click to edit it. 


 Add New Field menu: Select the type of form field to place in the form. 


 Preview: See how your form will look to your audience when they fill in the form. 


 Distribute Form: Send this form to other people to fill in. 


 Close Form Editing: Stop editing the form. 


After you convert your document to a PDF form, review it to make sure it contains all of the fields you require.  


To add a field to a PDF form: 


1. Make sure the form is in editing mode. If not, click the 
Forms menu, and click Add Or Edit Fields. 


2. Click Add New Field to display the Field Type menu 
(Figure 7). 


3. Select a field type, such as Text Field. 


4. On the page, click where you want to add the field to 
create a field with the default size. To create a field 
with a custom size, drag a rectangle to define the size of 
the field. 


 The field appears on the form, along with a Field Name 
box (Figure 8). 


5. In the Field Name box, type the name of the field and 
specify if you want the field to be required. Choose a 
name that is relevant and descriptive to make 
organizing and collecting the data easier. 


 The field name should be unique (that is, different from 
all other field names in the form). 


6. Click in the form (away from the new field) to deselect 
the field. 


 You can delete a field by selecting it and pressing 
Delete. 
 


 


Figure 7 Field Type menu 


 


 


Figure 8 New text field 
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Formatting form fields 


You can modify the fields in your lesson plan template in a number of ways. The Field Properties dialog box has 
four tabs (General, Appearance, Options, and Actions) in which you can format the text in form fields, add borders 
to form fields, set default values, limit the number of characters allowed, and so on. 


To format form fields: 


1. Click a form field to select it. 


2. Click the Forms menu, and click Show Field Properties. 


 The Field Properties dialog box appears (Figure 9). 


3. Select the Appearance tab (Figure 10).  


4. In the Borders And Colors section of the Appearance tab, 
choose a border color and a fill color for the form field. 


 Choosing colors for the form fields distinguishes the form 
fields from other elements in the form. 


5. In the Text section of the Appearance tab, choose a font 
and a font size for the field. 


 If you select Auto for the font size of a text field, the font 
size changes to fit the text in the box as the user types. 


6. Select the Options tab (Figure 11). 


 The options on this tab change according to the type of 
form field selected. 


 You can set a default (preassigned) value for the field; for 
example, in a text field, it is the text that appears until the 
user overwrites it by typing. Do this for fields that usually 
have the same value from one version of the form to 
another.  


 You can also set a limit on the number of characters 
allowed in a text field. 


7. When you have set all of the properties you want, click 
Close. 


 


Figure 9 Text Field Properties dialog box 
 


 


Figure 10 Appearance tab 
 


 


Figure 11 Options tab 
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Setting the form field navigation 


Forms are easier to use if the user can navigate by tabbing from one form field to the next. The tab sequence should 
occur in an expected and logical order. Setting tab order correctly also makes the form more accessible to people 
with mobility impairments. After you create your form fields, you can set the tab order of the fields in your lesson 
plan template in several ways: 


 In form-editing mode, you can order the tabs by document structure (default), row, or column. 


 You can manually drag fields in the Fields panel. 


 When not in editing mode, you can change the page properties to order the tabs by row or column. 


To set the tab order in form-editing mode: 


1. If you are not in form-editing mode, click the Forms 
menu, and click Add Or Edit Fields. 


2. In the Fields panel on the left, click Sort, and click Tab 
Order to select it (if necessary). 


3. Click the Tab Order button, and select a Tab Order option 
(Figure 12): 


 Default Tab Order: Based on the document 
structure and follows the order you set up in the 
tagging. 


 Order Tabs By Row: Starts with the upper left field, 
moving first left to right and then down, one row at a 
time. 


 Order Tabs By Column: Starts with the upper left 
field, moving first from top to bottom and then across 
from left to right, one column at a time. 


 Order Tabs Manually: You can drag a field where 
you want it within the Fields navigation panel. You 
can only move one field at a time. You can’t move a 
field to a different page, a radio button to another 
group, or a field to a radio button. 


 


Figure 12 Tab Order menu 


Using the form 


After you create a PDF form, users can fill in the form with the Hand tool or the Select tool from the Select & Zoom 
toolbar. When users place the pointer over a form field, the pointer icon changes to one of the following: 


 Pointing Finger  or Pointing Hand Plus : Appears when the pointer is over a button, radio button, 
check box, or item in a list. 


 Arrow : Appears when users can select an item in a list of options. 


 I-beam : Appears when users can type text into the form field. 







 Adobe Acrobat step-by-step guide 
 


© 2008 Adobe Systems Inc. Creating PFF forms 7 


To fill in a form: 


1. Make sure either the Hand tool or the Select tool is 
selected. 


2. (Optional) To make form fields easier to identify, click the 
Highlight Fields button on the document message bar. 


 Form fields appear with a colored background (light blue 
by default), and all required form fields are outlined in 
another color (red by default). 


3. Click in the first form field you want to fill in, either to 
select that option or to place an I-beam pointer in the field 
so you can start typing. 


4. After making a selection or entering text, do any of the 
following: 


 Press Tab or Shift+Tab to accept the change to the 
contents of the form field and go to the next or 
previous field. 


 Press the Up Arrow or Left Arrow key to select the 
previous radio button in a group of radio buttons, or 
press the Down Arrow or Right Arrow key to select 
the next radio button. 


 Press Esc to reject the change to the contents of the 
form field and deselect the current form field. If 
you’re viewing the form in Full Screen mode, 
pressing Esc a second time causes you to exit Full 
Screen mode. 


 If the current form field is a single-line text field, you can 
press Enter or Return to accept your typing and deselect 
the field. If the current field is a check box, pressing Enter 
or Return turns the check box on or off. In a multi-line 
text form field, pressing Enter or Return creates a 
paragraph return in the same form field. In all cases, you 
can press Enter on the keypad to accept the change and 
deselect the current form field. 


5. After you fill in the form fields, do one of the following: 


 Click the file menu, click Save As, and rename the 
file to save the form with the data you entered. 


 Print the form. 


  


Enable Reader users to save form data 


Most people use the free Adobe Reader to fill in forms. Ordinarily, Adobe Reader users can’t save filled-in copies of 
forms that they complete. However, you can extend rights to Reader users so they can do so. These extended rights 
also include adding comments, using the Typewriter tool, and digitally signing the PDF. 


To extend these rights, open the PDF document, click the Advanced menu, and click Extend Features In Adobe 
Reader. 


These extended privileges are limited to the current PDF. When you create a different PDF form, you must perform 
this task again if you want to enable Reader users to save their own filled-in copies of that PDF. 
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